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OVERVIEW
Scope AR
SCOPE AR is focused exclusively on bringing the benefits of augmented reality to industry. By bridging the gap
between the most advanced computer vision technologies and the best wearable and mobile hardware devices, we
provide industries with useful AR solutions that save them time and money by increasing comprehension and
maximizing efficiency. In addition, through WorkLink, we are committed to creating the best tool possible to make the
creation of these solutions a possibility for anyone. Our goal is the simplification of this process to the point where
users can create WorkLink instructional content as easily as PowerPoint™ users can create presentations.

The New WorkLink Create
The new WorkLink Create is the successor to the
Unity-based WorkLink Create (WorkLink Authoring
Platform). The user can create similar Work
Instructions with the new Create as the user could
with older Unity-based Create,  The content can be
consumed on the WorkLink apps available on app
stores or directly from the Scope AR CMS.

We developed this software to deliver three
fundamental values:

● Get authors productive quickly and
intuitively

● Gain powerful control over the knowledge
lifecycle

● Author painlessly directly from source CAD
files.

WorkLink Implementation

New WorkLink Create User Manual
3



The implementation of WorkLink follows the model illustrated above.

Authoring: Existing instructions and information, usually paper instructions, photos, videos and CAD models, are
used to create Smart Instructions using the New WorkLink Create Platform.

Publishing: Once ready for use (or testing), the Smart Instructions can be immediately published to the Secure
Content Server, which can be accessible via the internet or restricted to intranet (behind a firewall)

Workforce Access: These Smart Instructions are now available to any authorized personnel running any
compatible device (essentially any smart device with a camera)

Process Data: As the workforce executes the instructions, extensive information is generated, both active (data
entry, photos) and passive (date/time, location, time per step) and passed back to the server.

Insight: This information is formatted and made available to process management, to assist in everything from
inventory control to process improvement.

Technology
The new WorkLink Create Platform is the successor to the Unity-based WorkLink Create. Just as its predecessor, this
improved version was developed to dramatically simplify and accelerate the development and distribution of
augmented reality instructional content. In order to execute AR content, two components are required.

● System Configuration/Setup
○ 8GB of RAM (16GB recommended)
○ Graphics card with at least 1GB of VRAM (discrete hardware acceleration recommended)
○ A Chromium-based browser:

■ Google Chrome (recommended)
■ Microsoft Edge version 80+ (latest version)

Tips for optimum performance
Browser hardware acceleration activated. Visit this site for instructions on how to enable hardware acceleration in
Chrome. macOS machines (especially MacBooks) prefer to use the integrated GPU to save battery, and often won’t
switch to the discrete GPU automatically. To manually make the switch on MacOS platforms, please install and use
the gfxCardStatus app, available at https://gfx.io/

● Content Delivery Device
This is the device that the end-user will be holding (or wearing) when they access the instructional content. WorkLink
supports recent iOS devices (iPhones and iPads) as well as most recent Android devices, including smart glasses
such as the Microsoft HoloLens. The platform can be adapted to support new devices if/when necessary, although
new releases of iOS and Android devices generally do not require any specific support. Published content is accessed
on devices via the WorkLink application. Users can access their published modules by logging in and downloading
their instructions over the internet or private network, or by transferring the content via direct connection from the
authoring computer to the device (for those operating in ‘locked down’ network environments).

Browser Compatibility
The new WorkLink Create is compatible with Google Chrome, Microsoft Edge, Firefox and Safari browsers.
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USER INVITATION AND LICENSING

Invitation
Scope AR Admin can invite users to the new WorkLink Create platform by assigning them the required License on the
Scope AR Customer Portal.

For companies who have integrated their SSO to Scope AR, the company’s Scope AR Admin can choose to add
users rather than inviting them.

Visit articles: What does SSO mean? and What is the difference between “adding” and “inviting” a user? for more
information.

Accepting Invitation
Invited users must accept an invitation to
access the WorkLink Create Platform.

Required License for WorkLink
Create
The WorkLink Author license is required to use
WorkLink Create.

● WorkLink Author License
allows the user to create and
publish projects on WorkLink
Create. The licensed user can
also view projects on the
WorkLink App.

● WorkLink Viewer License
allows the user to view
projects on the WorkLink App
but the licensed user cannot
create or publish projects on
WorkLink Create.

Visit article: Licensing and License Management for more information.

New WorkLink Create User Manual
5

https://scopear.zendesk.com/hc/en-us/articles/360044144811-What-does-SSO-mean-
https://scopear.zendesk.com/hc/en-us/articles/360046145132-What-is-the-difference-between-adding-and-inviting-a-user-
https://create.scopear.com/
https://scopear.zendesk.com/hc/en-us/articles/360037870732-WorkLink-Licensing-and-License-Management


THE WORKLINK CREATE ENVIRONMENT
The WorkLink Create Interface
The new WorkLink Create introduces a refined User interface. Authors no longer need the Unity Software to create
and publish work instructions on the new WorkLink Create Platform. See the WorkLink Create Window Menu for more
information.

Creating and/or Opening a New Project
Related Article: How to create and open a Project/Scenario.

Creating a New Project:
● From the welcome screen, navigate to “New Project” on the top right hand corner of the screen to create a

new project. Users can still create a new project from within any project using the “File” drop down menu.

Opening a Project:
● From the Welcome screen, users can create a new project, open existing projects, upload a project, access

YouTube videos, Help Center, Contact Support and view updates on bugs/fixes and releases. To open an
existing project, double click the project and choose to open a newer Auto-save version or a manually saved
version. You can also right click and select “Version History” to choose a specific version of the project to
open.
Learn more: Welcome Screen - Overview.
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Available Tabs
● Recent - Shows a list of recent projects (Name of project, last edited date and the author)
● My Projects - Shows a list of all your projects and the last edited date.
● Shared with me - Shows a list of projects shared with you by other authors.
● Learn & Support - Shows shortcuts to YouTube Videos, Help Center and Scope AR Support.
● What’s New - Shows details of Product releases and Known issues and fixes.
● New Project -  To create a new project - Click on “New Project” (Top right hand side of the window)
● Upload Project - Click on the Upload icon (Top right hand side of the window)

Others -
● Application version is below (Left hand side of the window)
● Your username and Organization name is is above (Left hand side of the window)
● To sign out, click on the drop down icon beside your initial (Top right hand side of the window)

Saving and Loading a Project

Users can save and load the projects to a scene by selecting “Save” and “Open”
from the “File” drop down menu.

“Save” saves the current state of the Project while “Open” loads a different
project onto the scene.

By default, projects are auto-saved every 10 minutes. A user can enable or

disable this setting by clicking the button on the bottom right side of the
scene..

Publishing

Content is viewed on devices via the WorkLink application.

There are two methods of publishing, Online and Offline.

Online Publishing allows content delivery through connection to the
Scope AR Content Management System (CMS). Once this is
accomplished, modules can be added and updated via the internet.

● To publish a project online, click on the “File” drop-down under the
project name and select the “Publish Project” option or click on the
“Publish” button

Offline Publishing allows content installation via cable connection
between the new WorkLink Create Platform and the delivery device.

● To publish a project offline, click on the “File” drop down under the
project name and select “Download Scenario”. This option will download the .scope file, which can be
sideloaded on the device.

New WorkLink Create User Manual
7



Both methods require that the WorkLink app be installed on the delivery device being used. The WorkLink application
is available for free on the Apple App Store, Google Play store and the Microsoft Store.

Visit articles: Online Publishing and Offline Publishing for more information.

THE WORKLINK CREATE WINDOW MENU

The image below provides a reference for the various windows and areas you will need to know as you proceed to
work with the software. Please refer to it as needed.

1. File Menu
2. Edit
3. Window Menu
4. The Project name
5. Create
6. Help Menu
7. Publish

8. Share
9. Sequence
10. Default State
11. Step
12. Back/Forward button
13. Render Mode
14. Content Placement Step

15. View Settings
16. Gizmo
17. Alignment
18. Snap Settings

19. Tools
20. Start/Stop Simulation
21. Start Tour button
22. Sign Out

23. Scene camera/focus
selection/perspective
projection

24. Split Scene View

25. Marquee selection
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WorkLink Create Menu Options

The File Menu

The File menu allows you to create, save, load, export, publish and close projects.

● New: Clicking on this sub-menu overrides already open
projects to create a completely new one. You can also create
a new project from the Welcome screen.

● Open: Click to open a previously saved project from a list of
existing projects.

● Close: This option allows you to close the project in order to
return to your project list.

● Save: This option allows the manual saving of a project.
Different versions of a project are saved when an author
saves while working on a project. All projects are auto-saved
every 10 mins, you can disable this option.

● Duplicate Project: This allows you to create a duplicate
version of your project. Feel free to rename the duplicate
copy.

● Export Project: Click to download all assets of your project.
Export type can be  shallow, lightweight or full export. Learn more: Exporting and Importing your
project.

● Share: This allows you to share your project with other authors in your group or company.

● Publish Scenario: Click to publish your project online to the WorkLink App. (If applicable, select
recipient group(s) before confirming.)

● Download Scenario: Click to download current project as a publishable
offline file (.scope file). This is for offline publishing.

Edit

The Edit button can be used to make quick modifications to your project.
● Delete Unused Materials: Click option to delete unused materials

from your project.
● Preferences: Click option to adjust or customize General settings

and Timeline, Object Properties and Keyboard Shortcuts.

The Window Menu

The Window menu provides easy access to the sub menus available in the
WorkLink Create Interface. Once selected, a sub menu window can be
dragged and docked anywhere on the Scene.
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● Asset Library - This allows an author to upload, rename and delete

assets/files from your project.You are able to sort the Asset Library list

alphabetically using the sort icon on the top left corner of the Asset

Library window. Note: When you delete a model from your project, the

materials remain in the Asset Library. You can remove these materials

from the Asset Library by clicking on “Generated Scenario

Assets”>>Right Click “Materials”>> “Delete Unassigned Materials”.

● Object Groups View - This is used to categorize objects in the Step

Hierarchy into groups in order to animate them as well as to define their

visibility within the Object Properties.

● Revisions Editor - This is used for CAD file/model conversions and

revisions. Also known as Object optimization. You can see how deep a

hierarchy is and how many objects are displayed under Asset Revision.

Go to “Revisions Editor”>>Select Mode>>Confirm>>Base

Revision>>Advanced >>Expand Object to view the total number of

descendants of the node and its hierarchy level. Also see Advanced

Revision Editor.

Meaning of related symbols :
■ ▚ - The hierarchy Level of this node
■ ▲ - The total amount of triangles in this node and all of its descendants
■ ⌗ - The total number of descendants of this node

● Step Hierarchy - This is a tree-like structure that helps the software decide how to link up objects

and some of their parameters through a parent and child relationship. It shows how many

descendants each object has. Note: You can reset to the default the hierarchy of a step that has been

modified.

Meaning of related symbols :
▲ - The total number of triangles in this node and all of its descendants.
⌗ - The total number of descendants of this node.

● Checklist Editor - The Checklist editor allows an author to feature a checklist item (text, checkbox,

number, photo, multiple option, Yes/No or barcode) in a project. The priority can be set to passive,

force view or must respond. This data is available on the CMS.

● Sequence Editor - This shows you the full map of your projects, as well as the contents of any given

sequence in your project.

● Timeline Editor - This allows the editing of 3D content for each step, this includes creating timeline

animations. You can edit, copy and delete multiple timebars, objects and channels at once.

● UI Editor - This allows an author to design the project templates and provide relevant contents for

each step of the project.

● Object Properties - This lists all the components and properties of an object and allows you to edit

their values. Note: You can copy the object properties elements of an object and paste for another by

simply right clicking the specific properties bar to copy/paste.
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● AR Trackers - The AR Trackers view is used to create new or locate AR trackers on the scene. Learn

more about Image Tracking.

● Action History - This tracks all your actions on the scene making it easy to go back to previous

actions.

● Close All/ Collapse All -  “Close All” will close all opened sub- menus while “Collapse All” will

minimize the sub menu windows.

● Reset Layout - Reset Layout allows the automatic pop out of closed windows for Object Properties,

Step Hierarchy, Timeline editor and Asset Library on the scene.

The Project name

The project name is the title of your project/work instruction. A
user can provide a name while creating a new project or allow
the system to auto-generate a project name.Click on the “pencil”
icon beside the project name to rename it. You can also rename
a project from the “Welcome Screen” by right clicking the
project>Rename.  Learn more about naming and renaming a project.

Create

Create allows you to create objects/primitives. Click on “Create” to add the following to the
scene: AR Tracker, Empty Object, directional light, audio source, camera, 3D Text, Video
Panel and 3D objects. To enable Interactive Mode for your project, the camera added to your
project must be enabled using the button “Use for Interactive Mode” in Object Properties. Use
“Start Simulation” to see how the object will be displayed on the app.

Help Menu

Use the “Help” menu to stay up to date with release notes on new features, improvements
and fixes. Click on “Contact Us” to create a Support ticket.

Publish
The publish button allows you to publish your finished project online real
time. Upon successful publishing, you can log into the WorkLink App on
any supported device to view your project. You need the WorkLink Author
or Viewer license to access a published project on the WorkLink App.

Share
By default, you can access only projects you own (i.e. created by you) in WorkLink Create.
The Share button allows you to share your projects with other authors in your organization. You
can also share a project from the “Welcome Screen” by right clicking on the project>Share.
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Sequence/ Sequence Counter

This is the first sequence in the project. Further configuration can be done in the sequence editor window.
Author can continue the previous sequence by clicking “+” on the Sequence Counter. This is located at the
top left corner of the Scene.

Default State

For your 3D content, this will generally mean that any model(s) added to the scene in Default State will be
visible with their complete assemblies in every step of your project. It is a good idea to make any global
changes to your scene in Default State before defining other steps. Learn more: The Default State.

Step/ Step Counter

This shows all Steps in the selected sequence. It can be accessed through the sequence editor window.
Author can continue the previous step by right clicking the previous “step” and selecting “Continue Step” or
clicking “+” on the Sequence Counter. This is located at the top left corner of the scene.

Back/Forward Button

This can be used to quickly revert changes in your work by going a step backward or forward.

Render Mode
This shows a preview of the objects as they will be rendered in the WorkLink App. You can select Standalone
mode or device mode. Learn more about Render Mode.

Content Placement Step

This is also known as Author-defined Alignment allows an author to define what step(s) of the project
alignment will be initiated. An author is allowed to add a step or multiple steps before content placement by
simply dragging the content placement step button before or after the desired step.

View Settings

View settings allow you to toggle the visibility of the unit grid, visibility of sprites in the scene view and the
visibility of AR trackers in the scene view.

Gizmo
This is used to change the Scene windows icon sizes.

● Hide Gizmo (Shortcut is Q) -

● Translate - To change the selected object’s position (Shortcut is W) -

● Rotate - To change the selected object’s orientation (Shortcut is E) -
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● Scale - To change the selected object’s size (Shortcut is R) -

● Orient the gizmo to match the basic grid orientation -

● Orient the gizmo to match the selected object -

● Place the gizmo’s pivot at the pivot of the selected object -

● Place the gizmo’s pivot at the average center of the selected object’s bounding boxes -

Alignment
■ Object Axis X - Allows the user to rotate the content in the

X-axis relative to the set alignment point.

■ Object Axis Y - Allows the user to rotate the content in the
Y-axis relative to the set alignment point.

■ Object Axis Z - Allows the user to rotate the content in the
Z-axis relative to the set alignment point.

Snap Settings

Snap settings control the translation, rotation and scale levels of the object.  To
apply Snap settings to an object, select the transform gizmo, hold CTRL
command and move the object.

Tools
This allows you to measure the distance of the object on the
scene in meters, yards, feet, inches,centimeters or millimeters.

Start/Stop Simulation
This button allows the live preview of your project steps and animations. The purpose is to overview your
project before publishing. Your screen is completely frozen during simulation, therefore, no change can be
made until you stop simulation.

Start Tour button
Click button to initiate a tour of the WorkLink Create Environment,

Sign out
This option allows you to sign out of the application.
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Scene camera/focus selection/perspective projection

- Reset the scene camera to its default position.

- Move the scene camera so that the selected objects are in view.

- This is for perspective projection. It sets the projection mode to orthographic.

Split Scene View
This allows you to split and expand the scene view into two separate views vertically or horizontally.

Marquee selection

This shows the top, bottom, front, back, left and right views of a scene Object. Click and drag
Marquee for available views.

Content Placement Step

Content Placement Step, also known as
Author-defined Alignment allows an author to
define what step(s) of the project alignment will
be initiated.
An author is allowed to add a step or multiple
steps before content placement by simply
dragging the content placement step button
before or after the desired step.
Content Placement Step provides an opportunity
to create step(s) before alignment for information
purposes.

Content Placement Step is a part of the initial
sequence.

To use this feature for other sequences, simply
right click on the new sequence and select "set
as initial sequence" to copy over the content
placement step to the new sequence.

See: User Experience on the App.
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ADVANCED FEATURES

Timeline Editor

The Timeline Editor allows editing of 3D content for each step. This includes animating and positioning 3D objects as
well as defining which objects should be visible or invisible.

Animations for the scene are created, manipulated, and viewed in the timeline. Animations for individual items are
represented in the timeline by animation timebars.

It is possible to edit more than one

timebar/object/channel at a time. To drag and move

timebars/channels, hold down the “Control” key on

your keyboard and use the left button on your

mouse. Learn how: Edit, copy, delete multiple time

bars/channels.

To copy, delete, duplicate and replace objects, right

click the channel to select the function to use.

Simulating timeline animation

Simulation means the live preview of your project steps and animations before
publishing.

To simulate the current step as it will run on a device, use the "Play" button in the
Preview tools section or “Start Simulation” button located at the top of the Scene.

Click “Stop Simulation” to stop Simulation. For easier, but less precise, live previewing, simply drag the playhead back
and forth across the timeline and view the results in the Scene.

Your screen is completely frozen during simulation, therefore, no change can be made until you stop simulation.

Visit articles:Timeline, Create Timeline Animations, Simulate Timeline Animations for more information.

New WorkLink Create User Manual
15

https://www.loom.com/share/7e4459c3d9a646d68cf2c5d05867856e
https://www.loom.com/share/7e4459c3d9a646d68cf2c5d05867856e
https://scopear.zendesk.com/hc/en-us/articles/360048063992-New-WorkLink-Create-Timeline
https://scopear.zendesk.com/hc/en-us/articles/360046297711-New-WorkLink-Create-How-to-create-Timeline-animations-
https://scopear.zendesk.com/hc/en-us/articles/360047182771


Replace Project Asset (Asset

Swap)
Asset Swap allows the replacing of an existing
model with another in the scene.

● Open Asset Library

● Right click on the asset/model you
want to replace and click on “Replace
Project Asset”

● This action will launch the “Replace
Project Asset” window.

● Select the new asset/model and
compare objects in the old and new
asset.

● Enable “Keep Old Materials” if you
wish to.

● Hit “Confirm” to replace the old model
with a new model.

● The new model will be displayed in the
scene.
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Callouts
Callouts are descriptive text boxes that can be added to 3D objects.
You can set up Callout to create annotations and anchor them to
specific parts of an object under Object Properties. To enable and
configure Callout, go to Object Properties>>Callout>> Enabled.

You will be able to configure the following when Callout is enabled:

1. Visible: You can disable this option to make the callout
invisible.

2. Scale: To increase/decrease the size of the Callout.

3. Title: To give your Callout a name.

4. Title Color: To choose a desired color for the Callout
title/name.

5. Title Background: To choose a desired color for the
Callout title background.

6. Title Background Alpha: To adjust background color
shade as desired.

7. Content: To add additional content to your Callout, if
applicable.

8. Text Color: To choose a desired color for the Callout text.

9. Background Color: To choose an overall background
color for the Callout.

10. Background Alpha: To adjust overall background color
shade as desired.

11. Offset: To adjust the callout's position.

For more information, visit the article: New WorkLink Create: Callout.

New WorkLink Create User Manual
17

https://scopear.zendesk.com/hc/en-us/articles/360047359572


Object triggers (Non empty)
Object triggers allow you to add interactivity to scene objects. It can be set up to allow an object to act as a button that
takes the user to another step anywhere in your scene or an ON/OFF switch that controls the visibility of a specified
object. It can also be used for visibility of a callout.

To enable and configure Object triggers, go to:

● Object Properties
● Scroll down to Triggers
● Click on “Add Trigger”
● Select “Type” and Target Step

The type of triggers you can apply are Visibility toggle,
Move to Step and Callout toggle.

● Visibility toggle -  Available modes are Solid,
Ghosted and Hidden.

○ Solid: Causes objects to be solid,
regardless of their default setting.

○ Ghosted: Causes objects to be semi
transparent, regardless of their default
setting.

○ Hidden: Causes objects to be hidden, regardless of their default setting.

● Move to Step - Allows you to select a step to apply the trigger.

● Callout toggle - Allows you to apply triggers to a callout.

Project Link
The Project Link feature allows you to launch a
different scenario or project from within an active
session on the WorkLink App.
To enable project link in the New WorkLink Create:

● Select the object in the scene that will serve
as the redirection trigger.

● Click on Object Properties>> Triggers>>Add
Trigger

● Under Type, Select Project Link>> choose
mode (Online or Offline)

● For Online mode, select the project you wish
to link from the dropdown list. Make sure you
save the project before publishing.

Note

1. Offline mode allows you to specify a project that was published offline and manually published to your device.
You must ensure the project name matches what was published offline and includes the “.scope” file
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extension.

2. Linked projects must have been published (Offline or Online) from WorkLink Create.

3. Linked projects must be published to the same environment. For use in offline mode, both projects must exist
on the same device.

Image Tracking
Image Tracker allows you to align your AR Content in your environment using a specific or custom image or marker.

This video demonstrates how to configure Image Tracker
in the New WorkLink Create. Remember to upload your
custom image to the Asset Library before setting up the
Image Tracker for your project.

Object Tracking (Beta)
The Object tracking feature allows users to align and track

objects more effectively in the new WorkLink Create. This

feature is in beta and is applicable to HoloLens devices

only (at the moment).

Feel free to reach out to us at support@scopear.com if you

have any questions or concerns using this beta version.

Related Article:Configuration and Best Practices for Object

Tracking.

Configuration and Setup in the new WorkLink Create:

1. Click on Window Menu > Asset Library > Upload Files to upload the .obj file to be used for object tracking.

2. Click on Window menu > AR Trackers> Create AR Tracker to create an AR tracker.

3. Click on Window Menu > Object Properties, then

click on the AR tracker in the scene for further

configuration.

4. Click on the drop down arrow beside “Type” under

“AR Tracker and choose “Object Tracker”.

5. Click “Select Model” to choose the .obj file that will be used for tracking from the Asset Library. This is the .obj

file that was uploaded in step 1 above. The model will be uploaded to the scene.

Note:

● By default, the auto - pose (Called AutoInit in vision lib) is enabled. Auto - pose/ AutoInit is the automatic

configuration in VisionLib that theoretically allows the author to look at the model from any direction and begin

tracking.
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● If the author disables the Auto - Pose, he then will see the Initial Pose configuration:

● The InitPose with the author defined orientation and position defines the intended direction that the author will

start tracking the model from.

● In essence, these are camera values. To

initiate tracking you would need to look at the

object from the same position and angle. This

method is known to have faster alignment vs

Auto - Pose.

● For a specific configuration, an author can

tweak the Advanced Object Tracking

Settings. First, disable Auto -Pose and click

on the drop down arrow for “Advanced Object

Tracking Settings” to input required values.

Advanced Object Tracking Settings
1. Laplace threshold: Threshold in mm for

generating the line-model. This value

specifies the minimum depth distance

between two neighboring pixels necessary to

be recognized as an edge.

2. Normal threshold: Threshold for generating

the line-model. This value specifies the

minimum normal difference between two

neighboring pixels necessary to be

recognized as an edge. Usually we set this

threshold very high, because from our

experience normal-based lines can't be

recognized very reliably. It might make sense

to use lower values for certain models,

though.

3. Inlier Ratio Init: This is a quality threshold

for validating the tracking result during the

initialization phase. The value highly depends

on your scenario. If the line-model matches the real object perfectly and there is no occlusion a high value is

recommended. However, usually the line-model doesn't perfectly match the real object which is why a lower

value might work better. Then again if the value is too low the algorithm might start tracking the wrong object.

In our experience it is better if the minInlierRatioInit value is higher than the value for minInlierRatioTracking,

because it's difficult for the algorithm to recover from a bad initialization.
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4. Inlier ratio tracking: This is a quality threshold for validating the tracking result after the initialization phase.

The value highly depends on your scenario. If the line-model matches the real object perfectly and there is no

occlusion a high value is recommended. However, usually the line-model doesn't perfectly match the real

object which is why a lower value might work better. Then again if the value is too low the algorithm might

start tracking the wrong object. In our experience it is better if the minInlierRatioTracking value is lower than

the value for minInlierRatioInit, because we don't want the tracking to fail after the initialization due to effects

like motion-blur.

5. Line search length init relative: The model-based tracker projects the 3D line-model into the camera image

and searches for edge pixels orthogonal to the projected lines. The lineSearchLengthInitRelative specifies the

length of the orthogonal search lines in percent relative to the minimum resolution during the initialization and

tracking phase. Please use lineSearchLengthTrackingRelative and lineSearchLengthInitRelative in favor of

the non relative parameters since these parameters work independently.

6. Line search length tracking relative: Same as lineSearchLengthInitRelative, but used during the tracking

phase.

7. Line gradient threshold: Threshold for edge candidates in the image. High values will only consider pixels

with high contrast as candidates. Low values will also consider other pixels. This is a trade-off. If there are too

many candidates the algorithm might choose the wrong pixels. If there are not enough candidates the

line-model might not stick to the object in the image.

8. Key frame distance: The minimum distance between keyframes in mm. The line-model will only be

generated for certain keyframes. Therefore a higher value improves the performance at the cost of a lower

precision. Lower values cost more performance but increase the precision.

Recommended settings for Advanced Object Tracking Settings:
1. The only setting you might need to adjust is the "Laplace Threshold" (as it is influenced by model size).

2. You can roughly interpret this value as the maximum (width or height or depth) value of the 3D object

bounding box (on condition the object is not positioned smaller within the "Pose preview" window as in the

screenshot above).

3. Integer values are fine (doesn't need to be 100% exact), round up when in doubt. (eg. max object size is 3.2

meters, use value 4. Any object smaller than 1 meter, use value 1.)

4. After this is done, you can publish the scenario and try it out on your device.

Ideal scenario/best practices:
These are important tips for good object tracking (these are recommendations/ ideal scenarios, not limitations, the

more of these points are checked, the smoother the experience):

1. The .obj file uploaded under “select model” needs to be an exact 3D model of the object that is being

attempted to track in the real world. The accuracy of the 3D model vs the real life object is very important. The

.obj needs to be exported in the metric system, meter size (1 unit = 1 meter), as obj's do not contain a system

of measurement and Create imports it as "meter" size. (Support for more formats is on our roadmap.)
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2. Ensure that the .obj is correctly imported. Meaning correct scale (meter size), correct rotation (right way up)

and correct translation, before import. You can double check the size by importing the .obj into a step and

measuring it with the Tools - Distance Tool.

3. Create some sequences and steps that match the position of your .obj model used for tracking.

4. As this technology is comparing lines generated by edges (normals) in the .obj file with lines caused by

contrast on the real world object, the object being tracked in the real world should be uniform in color on

places where no edges are present. (eg. a camo print or development mule decals on an object would be the

worst case scenario.)

5. The lighting conditions in the real world should be optimized for optimal contrast recognition of shapes, so that

edges can easily be detected. For this reason, over- or underexposed objects will be more difficult to detect

(eg. a completely black object might be more difficult to detect edge contrast.)

6. Using Auto - Pose disabled (Init - Pose enabled), you can define the angle the end user needs to position

himself to initiate the tracking. This is ideally a position in which the object has recognisable

features/contours.

7. A good contrast of the real world object with its background is helpful. This helps to generate good contrast

for edge detection (e.g. a mid gray object on a white background.)

User Experience on the WorkLink App
1. Log into the WorkLink App.

2. Launch your project.

3. Look at the model from an angle which has a distinct silhouette with good consistent lighting. Preferably with

the model filling a large portion of the camera’s Field Of View.

4. Stay still and look at the object for approximately 10 seconds.

5. Pinch fingers or say “Set Position” to place once tracking is successful.

Example of how a line model based on edges

in the .obj (normal threshold) is generated, and

compares it with lines generated by contrast in

the real world image picked up by the camera.

More information on Object Tracking can be
found here:

● Object Tracking Explained
● Configuration and Best Practices for

Object Tracking
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TIPS AND SHORTCUTS
You can use the following tips and shortcuts when creating your work instructions:

● Camera Controls/ Scene Navigation

▪ Hold Right Mouse Button and drag to look around.
▪ Hold the Right Mouse Button and use W (forward),A (left),S (backwards),D (right),Q (up),E

(down) to move the camera around, hold SHIFT to double speed.
▪ Hold ALT and:
▪ drag with Left Mouse Button to orbit around the screen center.
▪ drag with the Right Mouse Button to dolly the camera.
▪ drag the Middle Mouse Button to the pan.
▪ Hold the Middle Mouse Button and drag to pan.
▪ Scroll the WHEEL to dolly the camera.

● Gizmo

▪ Use W,E,R change gizmo modes to translate/rotate/scale.
▪ W - Translate
▪ E - Rotate
▪ R - Scale
▪ Q - Hide Gizmo
▪ X - Change spaces (Local/Global)

● Snap to grid

▪ Ctrl + Shift + gizmo drag.
▪ It rounds up the position and increments in steps of 1
▪ Action History:
▪ Undo : CTRL + Z
▪ Redo : SHIFT + CTRL + Z
▪ Click an action to quickly “jump” to it

● Timeline

▪ Adding fragments (“boxes” like in the current WorkLink 1.0) to channels can be done by
recording or by right-clicking in the channel and choosing a fragment.

▪ Positioning fragments (drag the fragment itself left-right in the channel lane.)
▪ Resizing fragments (drag the edges of the fragment to make it shorter/longer.)
▪ Zooming the timeline horizontally with shift + mouse wheel.
▪ Zooming the timeline vertically with alt + mouse wheel.
▪ Timeline playback/pausing (click the PLAY / PAUSE word.)
▪ Time scrubbing (click and drag on the time strip - where the time markers are - to set the

current time point.)
▪ Drag loop marker (blue marker) to define the looping point.

● UI components

▪ Hide and show all UI components: CTRL + SPACE.
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● Scene objects

▪ Z - Switch between group center and object pivot.

● Tooltips
▪ This is presented on the bottom left corner of the scene when hovering on an icon/button.

● Autosave
▪ Activity progress autosaves every 10 minutes. Last saved time can be found in the bottom

right corner of the scene.

● WorkLink Create version
▪ This can be found on the bottom right corner of the scene.

Learn more about: Navigation Tips and Shortcuts.
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WORKLINK VOICE COMMANDS
There is a range of voice commands available to make users’ experience seamless on the HoloLens 2. These
commands are specific to the Login screen, Scenario/Contact list & AR view screen as well as within a Scenario. You
can view a list of available commands after logging into the WorkLink App and within a scenario. Simply.say “Show
help” to launch the command window specific to the active screen. See a comprehensive list of commands below:

Login Screen
1. User Name - Selects the username field on the login screen.
2. Password - Selects the password field on the login screen.
3. Log in - Logs user in after password authentication.
4. Advanced Settings - Launches Advanced Settings window.
5. Demo projects - Shows a list of available demo projects.
6. Forgot Password - Initiates a password reset.

Scenario/Contact List/AR View and within a Scenario
1. Align Project - Opens the “Alignment Panel” prompting you to place content..
2. AR View - Opens the AR view. Outside of a call, you can access the diagnostic window by air-tapping the

settings gear on the right side of the AR View.
3. Back - Takes you back one step in the current section.
4. Close Help - Closes the Help Window.
5. Call [User Name] - Attempts to call the named user, say “OK” to proceed, “Cancel” to cancel. E.g. Call

Support Test (Support Test is the username).
6. Clear Search - Clears the search box.
7. Contact List - Shows the Contact List.
8. Contacts - Same as above, shows the Contact List.
9. Exit Scenario - Attempts to end the Scenario.
10. Lock - Locks the WorkLink window, stops it from following your gaze.
11. Lock Interface - Same as above. Locks the WorkLink window, stops it from following your gaze.
12. Next - Proceeds to the next step.
13. Nudge -  Toggles the nudge mode. Allows adjustments to the alignment of your 3D content using the

following commands:

Undo Nudge Undo All Nudge Redo Nudge Rotate X Rotate Y Rotate Z Move

Moves object
back to its
previous position.

Moves object back to
its original position.

Moves object to
its nudged
position.

Enable nudge
rotation on the x
axis.

Enable nudge
rotation on the y
axis.

Enable nudge
rotation on the z
axis.

Translates the
x, y, and z
axis.

14. Place Content - Places your model/content in your environment.
15. Scenarios - Shows the scenario list.
16. Scroll [Up/Down] - Scrolls up and down the contact, scenario list and Settings..
17. Search - Shows the search box. Allows you to search for a contact/scenario.
18. Set Position - Fixes your content to its current alignment with a recognized target.
19. Settings - Shows settings page.
20. Show [App/Application/WorkLink] Help - Same as “Show Help”. Shows available voice commands.
21. Show [Interface/WorkLink] - Brings the main WorkLink Interface into view.
22. Show Help - Shows available voice commands.
23. Switch Visibility Mode - Switches visibility mode from Standalone to Device mode, vice versa.
24. Unlock - Unlock the WorkLink window, windows start following your gaze.
25. Unlock Interface - Same as above. Unlock the WorkLink window, windows start following your gaze.
26. View [Username] - Shows the current status of the user (Offline/Online status) and allows you to call.
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QUICK HOW-TO GUIDES
How to improve performance of heavy models with the CAD pipeline.

The CAD pipeline allows you to create a revision of your file/model based
on an existing one. To do this:

1. Upload your CAD file to the Asset Library.
2. Select "Revisions Editor" under the Window Menu.
3. Select the model file for the new revision by clicking “Select

Model”>>Confirm.
4. Choose between Simple and Advanced Mode. The Simple mode

is a simpler way to set your target to low, medium or high while
Advanced mode allows you to control the operation.

5. Click  "Confirm" once done.
6. The Revisions Editor window will show the status of the request

(Processing, Processing CAD, Rendering, Failed/ Done, etc.)
7. Close the Revisions Editor window when processing is done and

open the Asset Library.
8. You will see the revised version listed under the main file and you

can drag it to the scene like any other 3D asset.

Uploading models in zip files
You can upload a Zip file that contains multiple assemblies, parts and textures by uploading the Zip file to the Asset
Library.

Select a different root file from within the zip and generate a revision on that following same steps above i.e. Revision
Editor> >Create New Revision>Select Model>>Select File and process revision.

For more information, visit articles: Advanced Revision Editor and Improve performance of heavy models with the
CAD Pipeline.
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How to add Picture and Video Insets to your

project
You can add picture inset to your project from the UI Editor following
the steps below:

1. Transfer/copy the picture file to the Asset Library.
2. Go to UI Editor>>Template>Content.
3. Under “Insets”, choose “image” for Inset type
4. Click “Select image” to choose your image>>confirm.
5. Adjust the height and position using Inset Height and Inset

Anchor.
6. Use the “Start Simulation” button at the top of the scene to

preview your work.

You can add video inset to your project from the UI Editor following the
steps below:

1. Transfer/copy your file to the Asset Library.
2. Go to UI Editor>>Template>>Content.
3. Under “Insets”, choose “Video” for Inset type
4. Click “Select image” to choose a background image for your video>>confirm.
5. Click “Select Video” to choose your video>>confirm.
6. Adjust the height and position using Inset Height and Inset  Anchor.
7. Use the “Start Simulation” button at the top of the scene to preview your work.

For more information, check out video: How to add Video Insets to your project.

How to upload/rename/delete asset files
and create a model through the Asset
Browser
You can upload, rename and delete asset files through the
Asset Library. The Asset Library is listed under the Window
Menu.

Upload

● To upload files, go to the Asset Library and click on
"Upload Files."  The files will be uploaded to the
personal assets folder.

● You can also drag files from your computer to drop
in the Asset Library.

● To create sub-folders in the personal assets folder, click "Create."

Rename/Delete

● You can rename or delete a file from the asset library by clicking the "Edit" button.
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● To delete, you can also click the asset/material you wish to delete and tap the "Delete" button on your
keyboard.

For more information, visit article: How to upload/rename/delete asset files.

How to import a model to the Scene

To import a model to the scene, simply choose the model from the
Personal Assets or Company Assets folder, then drag and drop the
model into the scene.

● Once you have imported the model, Gizmo mode allows you
to change its position, rotation and scale as desired.

● Use W,E,R change gizmo modes to translate/rotate/scale.
You can assign/unassign the Key Bindings under the Window
menu.

For more information, visit article: Importing a model to the Scene.

How to create Callouts

You need to first enable callout to use it.

● Select the Object or part of the object you wish to apply
Callout on.

● Go to Object Properties
● Scroll down to Callout and click on the “Enabled” button to

enable/disable callout. For more information, visit article:
Callouts.

How to select parts of an object

The step hierarchy window displays the content within your scene and allows you to select, organize, add and remove
parts of an object from your scene.

For more information, check out the video: How to select parts of an object.

How to apply Visibility Mode - Standalone and Device Visibility Mode

Visibility Mode allows you to choose whether you are aligning 3D content onto the real equipment or without real
equipment. The Visibility mode for an object or a group can be set to Standalone or Device visibility mode in Object
Properties. To apply visibility mode:

● Select the Object/ part of the object.
● Go to Object Properties
● Click on the drop down arrow in front of the Device Visibility Mode Option

For more information, visit article: Visibility Mode - Standalone and Device Visibility Mode.
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How to create/modify project steps/sequences using the Sequence Editor

The Sequence editor is used to create or
modify steps and sequences in your project.
Select the Sequence editor menu and right
click the sequence or step for available
options:

Right Clicking Sequence

● Continue Last Step: This will create a
new step in which the timeline
continues the final frame of its previous
step.

● Add New Step: This will add a new
step to the sequence.

● Reverse Sequence: You can also
reverse a step through the context
menu.

● Set as Initial Sequence: This will
re-reposition a sequence in your
project.

● Rename Sequence: You can rename
any sequence by right clicking it.

● Copy Sequence: You can copy a sequence and paste it by right clicking an empty space>paste sequence.
● Duplicate Sequence: Duplicate a sequence in your project.
● Remove Ongoing Connection: Right click on the first sequence and select "Remove Outgoing Connection"

to delete a connection.
● Delete Sequence: You can delete a sequence by right clicking it and hitting "delete sequence" as long as it is

not the only sequence.

Right Clicking Step

● Continue Step: This will create a new step in which the timeline continues the final frame of its previous step.
● Continue Step Reversed: This will copy the step and reverse it.
● Reverse Step: You can also reverse a step through the context menu.
● Rename Step: You can rename any step by right clicking it.
● UI Template: You can swap UI template, apply changes to main template, reset all changes or go to main

template from this option.
● Copy Step: You can copy a step from one sequence and paste the step in another sequence.
● Duplicate Step: Duplicate a step within the same sequence.
● Delete Step: You can delete a step by right clicking it and hitting "delete step" as long as it is not the only

step.

Add/Connect Sequences

● To add a new sequence, right click on the background and click "Add Sequence"
● You can connect sequences by dragging the mouse pointer.
● To delete this connection, right click on the first sequence and choose "Remove Outgoing Connection".
● You can rename a step/sequence by double clicking it.

For more information, visit article: How to create/modify project steps using the Sequence Editor.
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How to customize Project templates

The User Interface (UI) editor allows the author to design the project
templates and provide relevant contents for each step of the project. To
customize a project template:

Go to the UI Editor and provide values for the following templates:

● Blank: Blank canvas, intended for custom step type.
● Intro Splash: Intended for use as the main project title page.
● Title: Intended for use as a title page for new sections.
● Content: Intended for use as a standard instructional step.
● Branch: A menu page to allow the user to branch to different

sequences.
● EULA: Intended for an End User License Agreement.
● Title Menu (6): A menu page with project title, project subtitle

and 6 options with links
● Title Menu (12): A menu page with project title, project subtitle

and 12 options with links
● Full Page Text: Intended for an extended length of the text to

explain a process
● Finish Procedure: This is the last page. This can come in the

form of a question with a "Yes or No" response option displayed
at the end of the session.

How to track activities with the Action History tab

The Action history tracks all your actions on the scene making it easy to go back to previous actions.

Shortcuts:

● Undo: CTRL+Z
● Redo: CTRL+SHIFT+Z

For more information, check out the article: Tracking your activities with Action History.

How to create Timeline animations
Follow the steps below to create timeline animations:

● Select the object you want to animate and hit the record  button.
● The movement of the object will be recorded and a track will be created in the timeline until you hit "Stop

Recording." A new time bar will be created inside the timeline. (You can record multiple transform changes for
the same object).

● Hit the play button to play the animation.

How to simulate timeline animations

The "Start Simulation" button allows the live preview of your project steps and animations. The purpose is to overview
your project before publishing.

● To start and stop simulation:
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● Click on "Start Simulation" to start the live preview of your timeline animation/project.
● Click on "Stop Simulation" to stop the live preview of your timeline animations/project.

For more information, visit the article: How to simulate timeline animations/projects.

How to create and open a Project

To create a Project:

● Log into the New WorkLink Create
● Click on “Create New Project” on the Welcome screen.

You can also create a new project from within an open/existing project by:

● Clicking on the File Menu and selecting “Create New Project”

To Open an existing Project:

● From the Welcome screen, search for the project using the Search box or Scroll bar.
● Click on the Project and click on “Open Project”
● To restore a manually or auto saved version of a project, select the project from the list and click on "choose

save", then select the version from  "Manual Saves" or "Auto Saves">> "confirm."

For more information, visit the article: How to create and open a Project.

How to invite and accept an invitation

Your WorkLink Admin must invite you to use the new WorkLink Create.

As an Admin inviting a User:

● Log into the CMS to send a user invitation.

As a User, accepting an Invitation:

● You will receive an email upon invitation.
● Click "Accept Invitation" on the body of the email.
● Enter your username and confirm your password>>Accept invitation.

For more information, visit articles: How can I add/invite a new user and How to invite and accept invitation.

How to rename a project

To rename your project:

● Click inside the text box or click on the rename pencil icon.
● Type in your preferred project name.
● Press the "enter" button on your keyboard or click anywhere outside the text box to save changes.

How to sideload a project on supported devices

Android

● Connect the Android device to your computer via USB.
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● Copy the published ".scope file" to \Android\data\com.scopear.RemoteAR\files\ on the device.
● Your content will now be available for use in the WorkLink App as an offline project.

iOS

● Connect the iOS device to your computer.
● Launch iTunes and select your device; choose the “Apps” icon, then “File Sharing”.  (Note: iOS on Windows

has iTunes, while MacOS has no iTunes);
● Copy your project file (.scope file) to the WorkLink Documents.
● Your content will now be available for use on the WorkLink App as an offline project.

WSA-Surface

● Open the File Explorer window and navigate to C:\Users\<Username>\Pictures\Camera Roll\
● Copy the project you downloaded into the Camera Roll folder
● Your content will now be available for use in the WorkLink App and feature as an Offline Project.

Note: You can also achieve this by copying and pasting the file into the location (Camera Roll folder).

Didn't show up?
● Try saving your content in

C:\Users\yourname\AppData\Local\Packages\ScopeAR.ScopeARWorkLink_qw0sdg9ragx7y\LocalState

HoloLens 1 and 2

● Log in to the HoloLens through the Windows Device Portal
● Navigate to the following location: System> File Explorer
● Navigate to the Camera Roll folder
● Browse your directory for the file you wish to upload, double click the file and select Upload
● Your content will now be available for use in the WorkLink App and feature as an Offline Project.

Note: You can also achieve this by copying and pasting the file directly into the location (Camera roll folder).

How to create a simple project in 10 quick steps

1. Log into the New WorkLink Create platform
2. Click on “Create New Project” on the Welcome Screen.
3. Give your Project a name and confirm.
4. Open Asset Library and upload your files/assets to the Asset Library (If you have not already).
5. Drag your model to the scene from the Asset Library.
6. Use the Scale Gizmo to increase the model’s size. Alternatively, open Object Properties and update the

scale values for  x,y,z. as desired.
7. Apply your desired template with the UI Editor.
8. Click Start Simulation to preview your project.
9. Click Stop Simulation to stop preview.
10. Click Save  & Publish Project under File Menu or use the Publish button to publish the Project online. For

more information, check out the video below:
● How to create Work Instructions using an Iphone 12.
● How to use WorkLink Create to build AR work instructions | PB650 ventilator example.
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https://youtu.be/GBvomy7fBRc
https://www.youtube.com/watch?v=vWGVMStrql8

